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The objective of this application is to evaluate the strength
characteristics of an upper-limb prosthesis (Fig. 1) by
simulating a distal tensile test with the finite element analysis
(FEA) module SolidWorks Simulation [WWW2022b] included
in the SolidWorks CAD package [WWW2022a]. The principle
of the test is shown in Figure 2.

_~Upper arm

_—— Forearm

P

As one may notice, the prosthesis is subjected to a distal
traction load after being firmly attached to a rigid support
that fitsinner surfaces of the upper arm.

The traction load gradually increases from 0 (zero) to 750 N.

o ¥
™=~ Effector

Figure 1: 3D model of the upper-limb prosthesis Figure 2: Principle of the distal tensile test simulated for evaluating the strength
characteristics of the upper-limb prosthesis (red surfaces — regions where the upper arm is
firmly attached to a rigid support; blue surface — support of the traction load)

This results was realised with the EEA Financial Mechanism 2014-2021 financial support. Its content (text, photos, videos) does not reflect the official opinion of the Programme Operator, the National Contact Point and the Financial Mechanism Office.
Responsibility for the information and views expressed therein lies entirely with the author(s)

qo‘-""""’c;f
“Ii e = - University b' 3=
J;E#:é{ﬁli i_______- @" UlA of Agder 10 OrmM 3

AN A



Ilceland [P’[I:Ij

Liechtenstein
Norway grants

Working together for a green, competitive and inclusive Europe

EUROPEAN NETWORK FOR 3D PRINTING OF BIOMIMETIC MECHATRONIC SYSTEMS - EMERALD

The following hypotheses are adopted when preparing the finite element model of the tensile test:

e The prosthesis components are made of PETG exhibiting an isotropic linear elastic behavior. Table 1 lists

the physical and mechanical properties of this material that are relevant for the finite element model of the
tensile test.

e The prosthesis components are bonded together along their contact surfaces.

Table 1: Physical and mechanical properties of PETG [Kan2020]

Mass density

p lkg/m’]

Elastic modulus
E [MPa])

Poisson’s ratio

vl

Yield strength
Y [MPa]

1270

1660

0.419

30.3
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The input files needed for preparing the finite element model of the tensile test are stored
in the folder Upper-limb prosthesis FEA:

Upper arm.SLDPRT — 3D model of the upper arm (Fig. 1)
Forearm.5LDPRT — 3D model of the forearm (Fig. 1)
Wrist. SLDPRT — 3D model of the wrist (Fig. 1)
Effector.SLDPRT — 3D model of the effector (Fig. 1)
Pin.SLDPRT — 3D model of the pin (Fig. 1)

Upper-limb prosthesis. SLDASM — 3D model of the prosthesis (Fig. 1)
EMERALD CAE Materials.sldmat — custom library storing the physical and mechanical
properties of PETG listed in Table 1.

The selection set Selection-Set1{10) Upper arm - Fixed (defined in the file Upper-limb
prosthesis.SLDASM) collects the surfaces where the upper arm is firmly attached to the rigid
support.

The displacement (deflection), force and stress quantities manipulated by the FEA model
are expressed using the following measurement units: displacement (deflection) — millimeter
[mm)]; force — Newton [N]; stress — megapascal [MPa] (1 MPa = 1 N/mm?).

The next sections of this documentation describe the preparation of the FEA model and
the interoretation of the numerical results.
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2. Preparation of the finite element model

The FEA model of the tensile test (Fig. 2) is developed by performing the following steps:

a) Open the Upper-limb prosthesis.SLDASM model in SolidWorks (Fig. 3).

a0 @ & TR [ — @

L= 1 [ -2
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e AT TS | -

Figure 3: Upper-limb prosthesis.SLDASM model open in SolidWorks
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b) Activate the SolidWorks Simulation module by accessing the “SOLIDWORKS Add-Ins” tab of the “Command
Manager” toolbar (Fig. 4) and pressing the “SOLIDWORKS Simulation” button (Fig. 5). Consequently, the
“Simulation” tab isincluded in the “Command Manager” toolbar (Fig. 6).
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Figure 4: “SOLIDWORKS Add-Ins" tab in the “Command Manager” toolbar
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Figure 5: “SOLIDWORKS Simulation” button in the “SOLIDWORKS Add-Ins" toolbar
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Figure 6: “Simulation” tab included in the “Command Manager” toolbar after the activation
of the SolidWorks Simulation module
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c) Change some working parameters of the SolidWorks Simulation module by accessing the “Simulation” menu
and selecting the “Options...” command (Fig. 7). Consequently, the “System Options — General” window is
displayed. In the “Default Options” panel, select the SI (MKS) unit system, then change the following measurement
units: length/displacement [mm] and pressure/stress [N/mm?2] (Fig. 8).
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Figure 7: “Options...” command in the “Simulation” menu Figure 8: Changes to be made in the “Default Options” panel of the “System Options —

General” window
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d) Add the folder Upper-limb prosthesis FEA to the list of places where SolidWorks looks for material libraries by
accessing the “Tools” menu and selecting the “Options...” command (Fig. 9). Consequently, the “System Options —
General” window is displayed. In the “System Options” panel, select the “File Locations” entry (Fig. 10). Unroll the
“Show folders for:” drop-down list and select the “Material Databases” item (Fig. 11). After pressing the “Add...”
button (Fig. 12), the “Select Folder” window is displayed on the screen (Fig. 13).

Look for the folder Upper-limb prosthesis FEA, select it and press the “Select Folder” button placed at the bottom
of the “Select Folder” window (Fig. 13). Press the “OK” button placed at the bottom of the “System Options —
General” window (Fig. 14).

e) Enter the “Simulation” toolbar and press the “New Study” button (Fig. 15) to create a FEA model having the
following characteristics (Fig. 16):

e name of the FEA model: “Static 1”

e type of the FEA model: “Static”.

Press the “OK” button placed at the upper-left corner of the “Study” window (Fig. 16).

This results was realised with the EEA Financial Mechanism 2014-2021 financial support. Its content (text, photos, videos) does not reflect the official opinion of the Programme Operator, the National Contact Point and the Financial Mechanism Office.
Responsibility for the information and views expressed therein lies entirely with the author(s)

up

TECHNICAL
UNIVERSITY

aaaaaaaaaaaaaa

i ViAviesy bizzoom




Iceland [P[I:Iﬂ Working together for a green, competitive and inclusive Europe
Liechtenstein
Norway grants EUROPEAN NETWORK FOR 3D PRINTING OF BIOMIMETIC MECHATRONIC SYSTEMS - EMERALD

,;S SOLIDWORKS File Edit View insert Simulstion  Window
« | P | & RARETY - enem] - “System Options” panel X
Hew B Export To AEC y : = y
& é Dowment Properties 2 Sesech Cpions Q
- . . | setect
. : . 5 A ~ Fecent dacuments
General zer C
Assembly | Layout | Sketch | Markup | Evaluate & Magnified Selection \_\ WED Baximum recent documenits displayed: E L
| Bos Salection
: = ; inciide doouments opened from ather douments
i i - n Drawings (mf
@B ! [ | & | @ S Lasso Selection ~"Tools" menu ¥
o A T i ey Display Style Qpen last used documents) at statup: | Nawer v
- = MArea Hatch/Fll
) 8 Upper-limb presthesiz (Default<Display Statel Ity Select a0 Ctrbe A Petainsines B jnput dimension valus
v & Histosy Colors [ single command per pick
v (i) Selection Sets e - Shetch [ Shew thumbnail graphics in Windows Esplarer
E :‘“"l'; Find/Madiy J Relations/Snaps Restare File Arzotiations
’ inotabons i
(1] Front Plane Resiarheckst . Display [] Use system separstar for dimensions
] Top Pane o Fomat Pante... Selection Use Engiis k e
:i] Right Plane Component Selectian v i““":l"““ L e & and file name
=5 ssermblies i H % o
g‘;!m Companant v External References w:r_// File Locations® entry
v &Gy B 1) Upper 1> Defauht< <Default>_Di Austo-shaw Eroj
2 (%: & () Forearm= 1> [Default< < Default> Disp Sketch Entities ® mﬂ e o-size PropertyMansger when paneis are split
» @ 78 () Wrist<1> [Defauk<<Defauht> Display|  Sketch Tooks . el nciom [ automatically edit macrs atter recording
v ol B (1) Efectore 1> DefaulceDefault> Diapl  Sketch Settings N Featunchianager |4 Stop vsTa debugger on magro exit
b @@ I Pinc1> (Defoultc<Defout> Display Site Blachs : Spin Bax Increments [ Enable Festurekpert
> 1B Mates Spiine Tooks v 7 ;-IM R [ Enable Freeze par
Dimensions * “-kup\ S ‘When rebuild emmor ooours:
Touch ; e i
Betiont 2 Hele Wizard/ Toclbax
KD Dy s i File Explorer Custom property wsed a5 component desoniption: Description ~
P e Search [ Show [atest Technical Alerts and News in Weltome dialog
¥ s Collaboration B4 check tor splutions when SOUDWORES crashes
Mescages/Emors/Wamings | £ Enabie sounds for SOLIDWORKS events
B symmetry Check. Impent
Export
& Large Assembly Settings Configure Sounds..
@ Make Smart Component.., B llows cosmetic threads for upgrade
Macro . SOLIDWORKS Customer Experience Improvement Program
= Izl me maorg.
i ' Tl me moes.
aluate [] Help make SOUDWORKS products better by automatically sending yous bog files to o
| — 1 NE Saliddnrks M arnaratinn
Addd-ine. " Options..." command in
SetefRechie it /" the"Tools" menu
Cuistormize.. 7
I_@ —— r oK Cancel Help
Custorrze Menu
TIETEIE] Madel | 30Wiews | Mobon Study 1 |

Changes options settings for SOLDWORKS, = Figure 10: “File Locations” entry in the “System Options” panel of the “System Options —

e
Figure 9: “Options..." command in the “Tools” menu General” window

This results was realised with the EEA Financial Mechanism 2014-2021 financial support. Its content (text, photos, videos) does not reflect the official opinion of the Programme Operator, the National Contact Point and the Financial Mechanism Office.
Responsibility for the information and views expressed therein lies entirely with the author(s)

o

TECHNICAL
UNIVERSITY

OF CLUJ-HAFDCA — =
BN AN A  1E1B

i ViAviesy bizzoom 10




Iceland [P‘[I:Ij

Liechtenstein

Norway grants

Working together for a green, competitive and inclusive Europe

EUROPEAN NETWORK FOR 3D PRINTING OF BIOMIMETIC MECHATRONIC SYSTEMS - EMERALD

System Options - File Locations "Show folders for:™ drop-down list X
{8 search ! Q
Gpstem Options  Dooument Progentiss o ety
General | I Show folders !or:l’
MED Dacument Templates ]T Edkit All
Drawings Custom Property Fikes ~
Display Style Design Checker Files e )
Area Hateh/Fill Desloy A STl Timpiate At [ ye———
o Design Library
SPE—c Dimension/Annotation Favarites L-laia Y ™
Colors DimXpert Callout Format File
Sketch Dimxpert Gensral Talerande File Meve Lip Crguniza = Do foicler -
Reelations/Snaps Drafting Standards Pt S S — e |3y
Displ Drawing Saale Standards : B Decumaric. # — . e
s.ll Fﬂ_—" Function Builder Segment Type Definstions by T Rk et "
g General Tables template - 4
Perfarmance Hateh Pattenn File Sy Gptiers - P Locans 5 & OneDive - Prrssr - Uppev-fimb prosthesis FEA folder salected
Assermnblies Hole Callput Format File vt Optans Deoument Propeties & 1 B i P
External References Hale Table Templates e = i
Default Templates TR DR ko I e
s Line Style Definitions Ermings fokies “ad.. button 1 Desitrg
MELCCRINS Bpay Sl e e T I Tsumerts
Featurehanager i P earerioa otk skt e Lot = i —
Spin Box Incremsents o
\.Ip; e A sie *Sedect Fokder® button ,
Arations e - & Phnures
/l Revision Tadle Templates Dawn
sact:p- Recover Search Paths § e B v
il Sheet Farmats Pk 05
Hole Wizard/Toclbox Shieet Metal Bend Line Mote File ~ e PR . \
File Expliorer Sheet Metal Bend Tables ~ "Material Datab " it ;::N ‘I:IM:: . - \-
Cediiely Sheet Metal Gauige Table e o e o i Fobde= | Ugpes-bemi prosthests FE4 \
Collaboration Spaling Folders ! :m::k--cw =
Messages/Emars/Warnings -
e
Impert - o ¥ 5 i : 9 2
E,,f,“ e Figure 13: Selecting the folder Upper-limb prosthesis FEA for being added to the list of places
2 - where SolidWorks looks for material libraries
et el 3 e G L0 FATRS foh
ehal e Fa s oo s WOl e I Al B
Reset..
Beet
vinind e = o | [

Figure 12: “Add...” button to be pressed for modifying the list of places where SolidWorks
looks for material libraries

Figure 11: “Material Databases” item in the “Show folders for:" list

This results was realised with the EEA Financial Mechanism 2014-2021 financial support. Its content (text, photos, videos) does not reflect the official opinion of the Programme Operator, the National Contact Point and the Financial Mechanism Office.
Responsibility for the information and views expressed therein lies entirely with the author(s)

o

TECHNICAL
UNIVERSITY

OF CLUJ-HAFDCA
FOMANIA

%

i ViAviesy bizzoom 11




Iceland [P[I:Ij

Liechtenstein
Norway grants

Working together for a green, competitive and inclusive Europe

EUROPEAN NETWORK FOR 3D PRINTING OF BIOMIMETIC MECHATRONIC SYSTEMS - EMERALD

System Options - file Locations

General
MED
Drawings
Display Style
Area Hateh/Fill
Performance
Colors
Sketch
Relotions/Snaps
Display
Selection
Pesformance
Assernblies
Extenal References
Default Templates
File Locations
FeatureMansger
Spin Box Increments
View
Backup/Recover
Touch
Hele Wizard/ Toolbox
File Explorer
Search
Collaboration
Mezsages/Errars/ Warnings
Import
Export

Beset...

System Options  Document Praperties {5} searen Options

Shaw folders for.
Materal Databases - Edit All

Eciders:

CHProgram Files\SOLIDWORKS Corp\SOLIDWORKS Jang)english\slamats
7

ogramData\SelidWorks\SOLIDWORKS 2021\.Custom Materials

) e s
“Upper-limb prosthesis FEA folder added to | e i
the list of places where SolidWorks looks
for material libraries

< »

Foiders containing the SOLIDWORKS Standard, DIN and Sustainability material
databases a5 well a5 the default ‘Custom Materials” folder and the SOLIDWORKS
Materials Web Portal’ folder cannot be deleted from the File Locations list.

,"OK" button

Help

=

Figure 14: Folder Upper-limb prosthesis FEA included in the list of places where SolidWorks

s [EE[e e
.

- & + KR

vty | Lok | e | Wrbay vt | SOUTWORKS A | Sottion | WED

looks for material libraries

———"Maw Study” button in the "Simulation” toolbar
>

Figure 15: Creation of a new FEA model

J’S SOLIDWORKS  # - - - é - . - - {f‘) =

2 @ Upper-lirnb prosthesis (D...

SEE[¢[@]

Study @
"OK" button
Message el

Study stresses, displacements, strains and factor of safaty for
components with linear material

/ Name of the new FEA model

Hame A
II Static 1 ]’
General Simulation A

Static

Mrype of the new FEA madel

] impart Study Features...

al  Frequena

Design Insight ~

e Topalogy Study

B9 Design Study

Advanced Simulation ~

Q| Themal

Chk  Buckling

O Fatigue

QG Moniinear

Y Linear Dynamic

— = o
Submodeling

Q@ Drop Test

Q) Pressure Vessel Design

b
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f) Press the right button of the mouse on the “Parts” entry of the FEA tree and select the “Apply Material to All...”
command from the drop-down menu to define the material properties of the prosthesis components (Fig. 17).
Consequently, the “Material” window is displayed (Fig. 18). In that window, minimize the “SOLIDWORKS Materials”
library, unroll the “EMERALD CAE Materials” library, unroll the “Plastics” category, select the “PETG” material, then
press the buttons “Apply” and “Close” placed at the bottom of the “Material” window.

Note: The yield strength Y = 30.3 MPa (see the PETG material data listed in Table 1 and Figure 18) definesthe upper
limit of the von Mises equivalentstressthat can be supported by the prosthesis components.

g) Do not change the option “Global Interaction (-Bonded-Meshed Independently-)” activated by default under the
“Connections” and “Component Interactions” entries of the FEA tree (Fig. 19). This option is consistent with the
hypotheses formulated in §1.
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h) Press the right button of the mouse on the “Fixtures” entry of the FEA tree and select the
“Fixed Geometry..." command in the drop-down menu (Fig. 20). Perform the following
actions in the “Fixture” dialogue box to define a full locking boundary condition on some
inner surfaces of the upper arm (Fig. 21):

+ Press the left button of the mouse in the “Faces, Edges, Vertices for Fixture” selection
box of the “Fixture” dialogue box

+ Unroll the assembly tree placed at the upper-left corner of the SolidWorks graphics
area

+  Unroll the “Selection Sets” entry of the assembly tree

+ Select “Selection-5et1(10) Upper arm - Fixed” in the assembly tree

+ Press the “OK" button of the “Fixture” dialogue box.
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Figure 20: Defining full locking boundary conditions
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Figure 21: Full locking boundary conditions defined on some inner surfaces of the upper arm
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i) Press the right button of the mouse on the “External Loads” entry of the FEA tree and

select the “Force..." command in the drop-down menu (Fig. 22). Perform the following
actions in the “Force/Torque” dialogue box to define the distal traction load that acts on

the prosthesis (Fig. 23):

Mote: The actual values of the traction force are defined in step (k) as load cases.

Activate the “Selected direction” radio button

Press the left button of the mouse in the “Faces, Edges, Vertices, Reference Points for
Force” selection box

Select the blue surface of the prosthesis effector in the SolidWorks graphics area

Press the left button of the mouse in the “Face, Edge, Plane for Direction” selection
box

Unroll the assembly tree placed at the upper-left corner of the SelidWorks graphics
area

Select “Front Plane” in the assembly tree

Press the “Normal to Plane” button in the “Force” region of the “Force/Torque”

dialogue box

Do not change the force value specified by default (1 N) in the “Normal to Plane” input

box
Press the “OK” button of the “Force/Torque” dialogue box.
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Figure 22: Defining a force-type boundary condition
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Figure 23: Defining the distal traction load that acts on the prosthesis
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j) Press the right button of the mouse on the “Mesh” entry of the FEA tree and select the “Create Mesh...” command in

the drop-down menu. Perform the following actions in the “Mesh” dialogue box to generate the finite element mesh:
e Move the “Mesh Factor” cursor to the “Fine” position

e Press the “OK” button of the “Mesh” dialogue box.

k) Press the right button of the mouse on the root of the FEA tree and select the “Load Case Manager” command in the
drop-down menu Consequently, the “Load Case View” tab is displayed at the bottom of the SolidWorks graphics area.

7. B Loadcaseview |8} g = EE

ot s G
Load Case Manager (Initial] = e =t 2 1
» G ros "~ “Run® button jelimmal.t 'g:” 2
» ¥ Connections o oy Lo Eeme =]
v L5 Fartures Load Case 1 = 150

L1 External Load ad Case =] 00

& Mesh Load Case 3 ] )

v [ER) Mesh Quality Plat Load Cose 4 M 500

[E] Result Options =] 750

Component] Condition  |Alert Value: :

|15 stress1 WO von Mig

5‘ Displacement1 URES: Resu

Transferring the finite element model to the SolidWorks Simulation solver
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3. Interpretation of the numerical results

As soon asthe solver finishes itsjob, the control istransferred to the
“Results View” tab which 29 is displayed at the bottom of the graphics
area. At the same time, a color map showing the distribution of the T— e ——

von Mises equivalent stress at the level of the entire assembly T A P
appears on the screen (Fig. 37)

_~"Results View" tab

~=First column of the "Primary Load Cases” table where the user can select the particular load
case to be analyzed

|5 Stresst (-vonMises-) | _—Entry of the FEA tree where the user can select the type of color map to be displayed
} Displacement! [-Res disp- | A~

WUATRIN] Madel | 30 Views | Motion Study1 | wnStatic1 |
SOUDWORKS Student Exdtien - Acaderic Lse Only

Figure 37: Analyzing the numerical results associated to different load cases with the help of
the “Results View” tab and the “Load Case Results” entry of the FEA tree
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Figure 38: Color map showing the distribution of the von Mises equivalent stress at the level
of the entire assembly (fourth load case: traction force of 600 N)
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Figure 39: Color map showing the distribution of the von Mises equivalent stress at the level
of the entire assembly (fifth load case: traction force of 750 N)
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Figure 41: Color map showing the distribution of the deflection at the level of the entire

\~"Lnad Case 4" selected in the first column of the "Primary Load Cases" table

assembly (fourth load case: traction force of 600 N)
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Figure 42: Color map showing the distribution of the deflection at the level of the entire

“"Load Case 5" selected in the first column of the "Primary Load Cases" table

assembly (fifth load case: traction force of 750 N)
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Table 2: Traction force, maximum value of the von Mises equivalent stress, and maximum

deflection corresponding to different load cases (see also Figure 43)

Load case Traction force Maximum value of the von Mises |Maximum deflection
F[N] equivalent stress ag,max [MPa] Amax [mm]

1 150 6.51 2.691

2 300 13.01 5.382

3 450 19.52 8.073

4 600 26.03 10.764

5 750 32.53 13.455
g = 000
. 2.000
= 100 3 000
. 0 150 300 450 600 750 o 130 i AN 500 750

Traction force [N]

Figure 44: Dependence Oeqmax Vs F: red dots — numerical results taken from Table 2; black
line — linear regression defined by Eq (1)

Traction force [N]

Figure 45: Dependence dmax vs F: red dots — numerical results taken from Table 2; black line —

linear regression defined by Eq (2)
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4. Suggestionsforindividual work

a) Evaluate the strength characteristics of the upper-limb prosthesis by simulating the distal
tensile test under the hypothesis that all the components are made of PLA exhibiting an

isotropic linear elastic behavior. Table 3 lists the physical and mechanical properties of this

material that are relevant for the finite element model.

Table 3: Physical and mechanical properties of PLA [Far2016]

Mass density
p [kg/m?]

Elastic modulus
E [MPa]

Poisson’s ratio

v[]

Yield strength
Y [MPa]

1252

3500

0.36

59

b)

Note: The properties listed in Table 3 are stored in the custom library EMERALD CAE

Materials.sldmat.

Develop another design of the upper-limb prosthesis and evaluate its strength

characteristics by simulating the distal tensile test.

This results was realised with the EEA Financial Mechanism 2014-2021 financial support. Its content (text, photos, videos) does not reflect the official opinion of the Programme Operator, the National Contact Point and the Financial Mechanism Office.
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